CWBench
(Release Version 2.0, December 2004)

John M. Sullivan, Jr., D.E., Director of Bioinformatics, sullivan@wpi.edu
James Q. Zhang, Ph.D., Research Assistant Professor, zqy@wpi.edu
Center for Comparative NeuroImaging (CCNI)
Bioengineering Institute, WPI, 100 Institute Road, Worcester, MA
# Table of Contents:

Acknowledgements: .................................................................................................................................................................................... 4  

CNI Workbench Manual ................................................................................................................................................................................................. 5  

Getting Started/ Introduction: ................................................................................................................................................................................................. 5  

Installation: ............................................................................................................................................................................................................ 6  

--- Notes for CWBench Version 2.0.X.X installation for WINDOWS === ................................................................. 6  

--- Note for CWBench20 installation for LINUX === ...................................................................................................................... 7  

Program Start & Exit: ................................................................................................................................................................................................. 9  

Finding Help: ............................................................................................................................................................................................................. 9  

Menu Bar: ............................................................................................................................................................................................................ 10  

File ............................................................................................................................................................................................................ 11  

- Open CNI File........................................................................................................................................................................................................ 11  

- Save XML File...................................................................................................................................................................................................... 11  

- Save CNI As.................................................................................................................................................................................................... 11  

- Import............................................................................................................................................................................................................. 11  

- Export............................................................................................................................................................................................................. 11  

- Close........................................................................................................................................................................................................... 11  

- Exit............................................................................................................................................................................................................. 11  

Edit............................................................................................................................................................................................................. 12  

- ROI & VOI .................................................................................................................................................................................................... 12  

- Domain........................................................................................................................................................................................................ 12  

- Filters......................................................................................................................................................................................................... 12  

- Operate...................................................................................................................................................................................................... 12  

View........................................................................................................................................................................................................... 13  

- Image Data...................................................................................................................................................................................................... 13  

- Geometries........................................................................................................................................................................................................ 13  

- Viewports...................................................................................................................................................................................................... 13  

- Orientation...................................................................................................................................................................................................... 13  

- Background...................................................................................................................................................................................................... 14  

- AutoCenter.................................................................................................................................................................................................... 14  

- Magnifier......................................................................................................................................................................................................... 14  

Applications ................................................................................................................................................................................................................. 14  

sullivan@wpi.edu  

CWBench Instruction Manual: November 2004 Version  
zqy@wpi.edu  

Center for Comparative NeuroImaging, Bioengineering Institute, WPI
Acknowledgements:

The authors add their thanks to the support staff and students that have made contributions to this work. Specifically:

Udo Benz - MS/Dipl. Ing., Research Engineer, Expertise: Image Registration, Web Development, System Administration

Hamid Ghadyani - Ph.D. Candidate, Mechanical Engineering Department at WPI, Expertise: Automatic conversion of atlases into three-dimensional segmented atlases suitable for numerical computation, automatic mesh generation.

Wei Huang - Ph.D. Candidate, Mechanical Engineering Department at WPI, Expertise: Marching cube surface generation and linearization algorithms. Multiple material marching cube routine developments and enhancements.

Praveen K. Kulkarni - Ph.D. Candidate, Mechanical Engineering Department at WPI, Expertise: Statistical analysis of functional MRI datasets

Murali Murugavel M S - Ph.D. Candidate, Mechanical Engineering Department at WPI, Expertise: Mesh generation, segmentation

Hongliang (Victor) Yu - Ph.D. Candidate, Mechanical Engineering Department at WPI, Expertise: Linear and non-linear image registration algorithms.

Shilpa Kinkar – M.S. Graduate Student, Computer Science Department at WPI, Expertise: Image segmentation and ITK utilization.

Miao Lu – M.S., Computer Science Department, WPI, Expertise: Web development.

Qiu (Autumn) Xia – M.S., Computer Science Department, WPI, Expertise: DICOM interface development, file utility routine.

Yingxin (Lucy) Zhang – Undergraduate research assistant.
**Getting Started/ Introduction:**

This software provides an intuitive graphical interface to view and analyze both image and geometry based data. The major target is MRI imaging and geometry (surface & volume) models constructed from such medical images. CWBench can import image and geometry data from a variety of format sources. It can translate them to other formats as well as our XML driven (Filename.cni) format. The CNI file extension is our acronym for Comparative NeuroImaging.

- **Image**, data are generally bitmap (pixel) data – B&W, Grayscale, Color, and other modes. It can exist as an individual file containing a single or sequence of image(s). Alternately, it can be multiple files of 2D image slices, which when stacked sequentially represent a 3D image set.

- **Geometry**, data are comprised of nodes or vertices (floats, etc.), the node connectivity such as 2D and 3D finite element meshes, polygons, etc., and scalar or vector attributes associated with the geometry.

- A combination of these data types can be supported simultaneously. *(See Basic Tutorial with Examples for more details on how to create these files).*
Installation:
=== Notes for CWBench Version 2.0.X.X installation for WINDOWS===

System requirements:
   Windows 2000 or XP
   At least 256Mb RAM
   To run SPM, MATLAB 5.2 or higher is required.

All CWBench software is stored within the CWBench folder. It does not write anything to system folders.

1) CWBench uses Tcl8.3.4

2) Unzip all files: CWB20BCxxxxxx.zip These zip files are 50MB or less in size.
   Each file should be unzipped into the same user-specified root directory, Ex: C:\
   Do NOT specify a root directory or path that contains spaces within its path and/or name.
   (An invalid example would be: "C:\Documents and Settings\John Sullivan\My Documents"
   Some 3rd party links, ex AIR, require this constraint.)

3) Add a Shortcut onto Windows Desktop for CWBench:
   a) On a blank region of desktop Right_click --> New --> Shortcut
   b) Paste the following line into the location of the shortcut target:
      "User-specified root directory"
      CWBench\CWBench20bc83\bin\wish83.exe CWBench.tcl
   where "User-specified root directory" is that selected by the user such as "C:\"
   c) Click on Next button and then rename the shortcut from "wish83.exe" to "CWBench"
   d) Click on Finish
   e) Right-click on shortcut and select "Properties" change "Start in" field to:
      "User-specified root directory"
      CWBench\CWBench20bc83\bcode
   f) Select "Change Icon..." and Browse to:
g) Select "OK"

4) Get a license key (cwb.ecl):
   - Connect to http://ccni.wpi.edu
   - Follow CWBench --> License
     - Enter required registration information
     - License will be sent as an email attachment.
     - Store the license key (attachment file) within:
       "User-specified root directory"\CWBench\CWBench20bc83\bcode

5) Launch CWBench by a double-click of the Desktop Icon.
   - System requirements:
     - Windows 2000 or XP, Linux (Redhat V9+ and SuSe V9+ tested), SGI
     - More than 256Mb RAM
     - Minimum display resolution 1024 x 768

6) Launch CWBench from the Desktop Icon.
   - Files with the extension ".cni" (and format) can be opened directly from the ‘File’ pull-down menu. Several of these files already exist in the CW-Examples folder. Alternate format files need to be ‘Import’ via the ‘File’ pull-down menu.

--- Note for CWBench20 installation for LINUX ---

- System requirement:
  - Redhat Linux 9, Suse Linux 9 (other Linux platforms might work as well)
  - More than 128Mb RAM
  - Untar file: CWB20BCodexxxxxx.tar.gz
    - tar xvfz CWBench-linux.tar.gz
  - Copy examples to local drive.
  - Create a Launcher on Desktop for CWBench:
    - right-click on desktop
    - select New Launcher
Name: CWBench  
Command CWBench/cwbench  
Icon: CWBench/cwb2_83/res/Ccni2.ico

4) Get a license key (cwb.ecl) from http://ccni.wpi.edu,  
   put the license key under the main directory: CWBench/cwb2_83

5) Launching CWBench by click the Icon. Open the files  
   with extension ".cni" under example directories.

6) To run SPM, you need MATLAB 5.2 or higher.
7) To have native AIR package working properly, you should add working path  
   to the AIR directory under CWBench.
Program Start & Exit:

With CWBench installed and the display drivers functioning correctly, CWBench should start by double clicking on the CWBench desktop icon. If the program does not start, please contact the support staff at http://ccni.wpi.edu/

The program displays a credits screen which can be closed at any time. The default program screen contains a left panel identifying the View status to be ‘Images’ and the sub-tab category of ‘Display’. To the right of the panel are 6 graphic viewing windows: a large (256x256) window with a green background for 3D data display. Five smaller (128x128) image windows have a black background. They are for display of 2D data. Background colors and view layouts can be changed without difficulty.

To Exit CWBench select ‘Exit’ in the ‘File’ pull-down menu or mouse-click on the ‘X’ in the upper right hand corner of the program window.

Finding Help:

In CWBench, the ‘Help’ menu is located at the top of the program menu bar. It provides remote access to the ccni.wpi.edu website for interactive help. This facility is still being developed. A PDF file of the manual is available.

About CWBench – Software logo and release information. Help tabs are located within numerous applications and tool menus. These ‘Help’ tabs are active and provide a brief description of the components specific to that control panel menu. Additional help exists on some functions when the mouse cursor ‘hovers’ over a button or input field. A small pop-up window appears next to the cursor with a brief explanation of the feature.
Menu Bar:
Many functions and features can be accessed and changed using the pull-down menus located at the top of the program window. These menus can be ‘torn’ off the menu bar and placed on the desktop by a single left-click on the dashed line under each menu. The selected menu stays on the desktop and functions as a separate window until closed by clicking on the “X” in the upper right hand corner of the menu window. It can also be minimized, maximized, and moved like any other program window. One can still use the pull-down menus in the main program window independent of the ‘tear’ menu on the desktop.

Menu items followed by an arrow > indicate a second level menu is available under that title. Second level menus can be pulled out onto the desktop in the same manner as the main menus from the menu bar. Menu items followed by … will prompt the user for further information.
File

*Open CNI File...*
Opens an existing CNI file.

*Save XML File...*
Saves the active CNI file in XML format and extension.

*Save CNI As...*
Saves the active CNI file with a new name, drive, or path.

Import

*Image Data*
Imports image files with formats: Plain Raw, Explicit Raw (Photoshop), SDT (Stimulate), IMG (Analyze/AIR) and BMP.

*Geometries*
Imports geometry data in Visualization Toolkit (VTK) format, Thayer School Mesh File format, WPI Mesh File formats. See appendix for details.

*CNI File...*

Export

Exports images in a variety of formats, such as Raw, or sequential slices.
Exports geometries (node and element files, etc.) in a variety of formats.

Close

Closes all files currently opened.

Exit

Quits the application.
Edit

ROI & VOI
Opens the submenu for creating/modifying Regions Of Interest (ROI) and/or Volumes Of Interest (VOI).

Domain...
Converts frequency/spatial/complex/real domains from one mode to another.

Filters...
Apply High or Low pass filters to user-specified datasets.

Operate...
Apply various Boolean cropping options and masks.
View
Hide Panel
Toggles the command panel status (Hide or Show).

Image Data
Displays the Images command panel for Display/Import/Export/Help Options. This control panel contains numerous tools including the ability to adjust image properties of all loaded slices, import slices from file(s), and alter color and contrast of images. This panel is described in a subsequent detailed chapter.

Geometries
Displays the Geometry command panel for Display/Import/Export/Clip/Utilities/Help Options. This control panel contains numerous tools including the display of 3D geometry data, the display of scalar, vector, and tensor solutions onto the geometry surface and volume datasets. Varieties of clipping operations exist as well as rotations, animations, pan and zoom tools. This panel is described in a subsequent detailed chapter.

Viewports
The various viewports available for 2D and 3D display characteristics. The 2D viewport displays one large (512x512) pixel window of a 2D image. The 3D viewport defaults to a (768x700) pixel window. This is the only view that can be resized by the user. The 2D display window sizes are fixed since the data are integer pixels. Remaining viewports are divided as shown, each with at least one 2D window and a 3D window. The 3D window is distinguishable by its default green background. A checkmark identifies the currently selected viewport.

Orientation
Changes the orientation of the 3D window so that the selected direction is the full-face view on the screen.
Background
Changes the background color of the 3D window. Default is set as Emerald. Other choices include: Black, Grey, Sapphire, and User-Specified.

AutoCenter

Image Box:
This function centers (and autoscales) the image within the display window.

Geometry
This function centers (and autoscales) the geometry within the display window.

Magnifier
Opens a new window on the desktop. Magnification can be selected via the slide bar at top or a numerical value (on a scale of 1 to 10) entered in the box next to the slide bar.

Applications
(Detailed explanations of these applications are provided in subsequent chapters.)

Registration
- Affine transformations of slices: translation (positioning), rotations, and dilation (scaling).
- Transformations can be manual (via slide bars) or keyboard entry.
- Direct links to 3rd party registration software.

Mesh Generation
- Creation of surface meshes using a multiple-material marching cube algorithm.
- Creation of volume meshes using surface mesh data as input.

fMRI Module
Complete functional magnetic resonance imaging (fMRI) is a complicated and iterative analysis. This module walks one through the steps in sequence. Multiple pathways are presented to obtain the final result. The suggested path starts with subject registration (alignment) to one another and to a reference atlas. The reference atlas alignment
facilitates the segmentation (color-coding) of the brain into regions and sub-regions. The brain activity can then be statistically analyzed and tabulated relative to the regions identified by the user.

Analysis

This menu pull-down will be expanded in future software updates. It will provide direct access to analysis routines, such as the fMRI t-test module. However, at this time the menu selection is limited to a histogram function.

Histogram

The user can select an image set for analysis. The frequency of pixel intensity groupings is displayed. Adjustments in the histogram distribution are available.

Tools

Marker

Geometry based coordinate markers (fiducial markers) can be added by the user on 2D/3D view windows.

Markers are grouped in user-specified lists. A group or list must be active prior to any operations such as add/delete/select points, etc. Multiple groups or lists can be created.
Operations on Markers:
First select marker operation and then use 'Ctrl + Mouse Click' for Operations.

Markers can be used to highlight regions of interest and they can be easily used for registration. More detailed marker operations are explained in Applications->fMRI Module.

Slice Control
The Slice Control tool displays the current settings of each 2D graphics window. The controls are color coded consistent with the graphics window color identifier. These slice settings affect the clipping locations displayed in the geometry.
application as well.

The ‘FgSlice Opacity’ requires that it be turned on and that both Foreground and Background images be active. If these two conditions are met, then sliding the control bar modifies the opacity of the foreground image set relative to the background image set.

Each set of colored options on the menu represents a different box on the window whose color matches that of the menu. There are several features available for each color coded set.

The colored slide bar can be moved to display different image slices of the dataset. The system loads an image set and interpolates all images in different orientations maintaining the same aspect ratio. The number box adjacent to the slide-bar shows the current image slice displayed. One can enter a specific numerical value in this box for direct display of that image.

Four button controls, each with two options exist. The smaller square pale colored button affects all windows for that specific function. The rectangular color-specific button affects the individual colored window only. The Orientation button ‘Or:’ sets the orientation. There are numerous options for orientation. The background (Bg:) and foreground (Fg:) buttons can display separate image sets if desired. This feature is helpful when trying to register one image set to another. Each fore- back- ground window can be turned on/off using the adjacent buttons to the right of the control buttons.

- The ‘V’ button is the 3D ‘Visible’ button. If activated, the imaged displayed is viewed in the 3D window.
- The ‘R’ button reformats the image in the window.

The 'Active Slice Control' panel enables one to manipulate advanced slice controls over each viewport. Each little colored bar represents a different viewport on the window whose color matches it. One can select a particular colored set and specify its zoom and slice increment, or save the current slice as an image file.

*View Setting*
Opens the View Setting panel wherein one can adjust the pixel size of the 3D mode window only. Other view settings are available from this menu selection as well.

Movie Recordings
The user can create movie files (sequences of still images numbered sequentially). The start frame number, directory, and file type are user specified. Several 3rd party utilities can append the file sequence into an AVI or MOV file. QuickTime Pro does a wonderful job of the task.

Annotation
Various methods of annotation may be toggled on or off by depressing the panel buttons. When toggled on, they will display as appropriate in the viewing windows. When toggled off, they are hidden from view.

Help
In CWBench, the ‘Help’ menu at the top of the program is not yet implemented. Eventually, it will provide access to all the help features.

Documentation
Opens an online version of this user manual.

Using Help
Reminds one how to find help throughout the program:
Hover the mouse cursor over a button or input field. If available, a small yellow box appears next to the cursor with a brief explanation of the feature.

About CWBench
Software logo and release information.

However, each ‘Applications’ selection has a ‘Help’ tab within the left control panel. Those ‘Help’ tabs are active and provide a brief description of the components within that application. Additionally, if the mouse cursor ‘hovers’ over a button or input field a small pop-up window appears next to the cursor with a brief explanation of the feature, if available.
Working with Files

This section includes information about CWBench’s different file types and some file management tips.

File Types

Plain Raw - Usually contains one slice of image in single file. It uses file extension to number slices -- a set of files with same file name and numbering file extension. e.g: xxx.001 xxx.002 ... xxx.00n or xxx.1 xxx.2 ... xxx.n. CWBench recognizes the slice range through the file extension within the same folder. Raw format does not include header information. The user is responsible for providing correct header information.

Explicit Raw - Has a file extension of '.raw' -- Photoshop prefers this form. This type of raw file can contain a single image, but usually includes multiple slices within one file. While loading, CWBench will put 'unknown' in the last slice and slice range fields to remind the user for input. Note that the first slice number/index defaults to 0. As with plain raw format, the user should provide complete header information even though CWBench has default header settings.

SDT - The native format of STIMULATE. SDT format includes two files, *.spr and *.sdt. The .spr file contains header information and the .sdt file has the image data. Both files need the same file name and be in same file path. Generally, CWBench will extract the header information from the parameter file without user intervention. There are some simplified spr files that were generated by utilities other than Stimulate. These files only include minimum header information such as image size and number of slices, thus the user should fill in the rest of information.

IMG - The native format of Analyze. The img file has a separate header file (*.hdr). The .hdr file contains all of the header information except, unfortunately, the endian type. Sometimes, IMG format mixes up signed short and unsigned short -- both are 16 bits -- which can cause problems. CWBench allows the file to be loaded multiple times so that unknown (or forgotten) parameters can be determined, such as big/little endian format and signed/unsigned short, etc. Each attempt to load will display the results, but they are not entered into the data structure until the user selects ‘Apply’ within the import options. Some other software, such as A.I.R. use .img as its file extension identifier as well.

BMP – A generic Windows format supported by many software products. A BMP file contains image size information. Similar to other file formats, BMP files can contain an image volume set. However, the user must fill in some header
information; otherwise the image is assumed to be a single image. The BMP missing header information for an image volume are pixel size, slice thickness, scan order. Multiple image slices can exist in sequential formats, similar to *.raw files, but the file sequence is identified by the numbers immediately preceding the file extension, i.e. xxx001.bmp xxx002.bmp ... xxx00n.bmp or xxx1.bmp xxx2.bmp ... xxxn.bmp.

Naming Files

When CWBench prompts you to type a filename, you can use up to 259 characters to create a name for the file. If you want to use the CWBench default extensions, do not type a . or an extension after the filename. CWBench automatically adds the appropriate default extension.
View

The *View* menu provides access to two main display operations, the “Image Data” and “Geometries”. Within these submenu selections one can import, export image data and geometries, clip, move and rotate geometries for viewing convenience.

This “View” menu also provides the ability to change viewports, orientation, background, or to have a magnifier window.
Images

The *Images* application can be used to enhance, as well as view, image slices.

When the Image application is chosen, the left side of the window displays the Images menu. (CWBench opens the Images application as default when the program starts.) The menu has five tabs at the top: *Display*, *Import*, *Export*, *Other*, and *Help*. Each tab has a sub-menu specific to that function category. The *Help* tab displays useful help information and is available for all the applications.

**Display**

- **Active Volume** displays which volume set will be modified via the parameters below. The Active Volume display is independent of the images displayed in the graphic windows. Those images are controlled by the ‘Fg’ and ‘Bg’ foreground settings in the ‘Slice Control’ application.
- **Width/Level**: sets which pixel values will have the most visible range. You can set these values manually or allow CWBench to do it for you automatically by selecting the appropriate button.
- **Threshold**: Set visible thresholds at Low/High ends. Again you can set these values manually or allow CWBench to do it automatically by selecting the appropriate button. Press ‘Apply’ when you have finished setting the thresholds to impose these changes onto the slices.
- **Palette**: select the color scheme for the data.
- **Interpolation**: indicate whether to interpolate between voxels. Toggle this option On or Off.

**Import**

To import image datasets:

- Select file(s) that you wish to import by browsing for the first image file. CWBench will automatically detect the last slice in the same directory, or you may specify otherwise in the input box.
- Select the header tab to display/modify header information for the images.
- The DICOM tab allows that specific type of medical image format data to be imported to CWBench.

- Once the data is selected press ‘Apply’. If the images do appear correct change the settings in the header tab and reload the images. This can be done iteratively. The header tab provide data type changes such as char, short, int, float, double, etc.

### Export

To export image datasets:
- Select the Volume Set that you wish to export.
- The header tab displayed shows some of the typical information for the images.
- The DICOM tab allows that specific type of medical image format data to be imported to CWBench.
- Under the Export ‘Properties’ tab the option to ‘Apply’ is available.

### Other

- The Slider Range for the Width/Level/Threshold sliders is normally automatically set according to the min and max voxel values in the volume. If desired, they can be altered explicitly here.

The image properties of all the loaded slices can be modified together. Some properties allow individual slice modification as well. If one imported the images, it is possible to save the entire import set and all the specific parameter settings as a *.cni file. If the *.cni file format was selected then subsequent loadings of the *.cni file will reload all initial parameter settings.
Geometry

The Geometry application can be used to display 3D data simultaneous with image slice information. It allows the user to modify (visually) this geometry data to show specific sections of the object. The 3D object, in the 3D viewport, can be rotated, zoomed, panned via the left, right, scroll mouse buttons, respectively. The user has the option of changing the opacity of the object to see image and/or other geometry data within it. Each geometry model is displayed in the control panel list. The color and other parameters can be changed by right-clicking on the geometry model name. The Geometry menu has five tabs at the top: Display, Import, Clip, Utilities, and Help. You can click on any of these tabs to show the sub-menu within that topic.

Display

- Choose the Rendering Screen where you would like to view the model (default, and currently only, is the green 3D screen)
- Choose the render type to display the model as a Wireframe or Surface model.
- Click the button with the model's name to toggle its visibility, and move the slider to change its opacity. For additional options, right-click the model’s name.
- You can click on ‘Show All’ or ‘Show None’ to toggle all the models on or off at once.

Import

- Currently the only default geometry format is *.vtk. Other geometries formats are scheduled. If geometries are imported one must select ‘Apply’ before the effects become part of the data structure. Again, if one saves the file as a *.cni file all geometries, image data sets and their settings are preserved in the *.cni file.

Clip

- The image slice planes can act as clipping planes to view the inside of the model. In order to have ‘Clip’ active, the geometry model (listed in the ‘Display’ submenu) must have ‘Clipping’ active in its structure. Under ‘Display’ right-click the specific geometry model and verify that ‘Clipping’ is activated. Toggle the slice panes On/Off to clip at that slice’s position.
- For each slice pane, choose whether to clip the portion of the model above (+) or below its (-) the current slice layer status. (By doing so you are toggling that slice pane ON to be clipped). Press OFF if you wish to turn off the clipping for that slice. You may change the effect of clipping by toggling multiple planes.
- The ‘Clipping Type’ determines if the clipping mode is either the Union or Intersections of those activated.
- Press apply to accept changes.

**Utilities**

- The Geometry can be rotated, spun, or panned using the button option and arrow indicators. Select the moving type (either Rotate, Spin, or Pan) and click the direction arrows to move the model.
- The Measure Performance function is not operational at this time.
- Note: One of the options available is ‘Backface Culling’. This is a VTK related function that enhance the visualization at times. However, at times it produces inconsistent results. If the visualization appears somewhat unexplainable, check the status of the ‘Backface Culling’ flag.
Applications

There are three main applications currently available in CWBench. These applications are: Registration, Mesh Generation, and functional MRI.

Registration

The Registration application can be used to modify the size, shape and location of an image slice, a set of slices and/or geometry models so as to conform to other images or geometry models. The manual alterations work interactively.

Matrix:
- The Matrix tab displays the current 4x4 transformation matrix for the ‘Active Matrix’ selected. The transformation matrix entries can be changed manually via the 4x4 window. However, the primary mode is via the ‘Manual’ tab options.
- The ‘Identity’ button purges the current 4x4 matrix and replaces it with the identity matrix.
- The ‘Invert’ button takes the current 4x4 matrix and provides the inverse of the matrix. This feature is useful for providing the necessary transformation matrix to modify the ‘non-active’ matrix to the active matrix. For this feature to be beneficial one must register only one image set. If so, then the inverse matrix can register the non-active matrix to the active matrix.

Manual
- You may set the registration matrix using manual registration through adjusting 3 translation, rotation and scales values.
- The function allows you to choose whether you would like to change the active slice, all the slices, or the 3D geometry.
- Translation, rotation, and scale factors may be changed in 3 orientations, LR, PA, and IS. Move the sliders under each orientation to see the changes on the active slice(s).

Auto-AIR:
- The Auto-AIR function (Automatic Image Registration) has not yet been implemented yet. The A.I.R. product provides automatic registration for contrast-based image data.
Mesh Generation

The Mesh Generation program is used to create volume mesh objects when given surface mesh data to model. It can either create a Script file which can be used as input when running SpMesh, or it can automatically run SpMesh within CWBench and load the resulting mesh geometry onto the CWBench display.

SpMesh

There are three menus to be filled out before the volume mesh files can be generated. Input, Refine, and Output. The three buttons that are associated with each menu are located at the top under Settings. The “Next” and “Back” buttons on each menu will also help you navigate between the menus.

- Under Input, select the boundary input file (surface mesh) using the Browse button, or type the address of the file into the input box.
- Use the default internal normalization factor (1.0) and maximum auto-refinement limit (0.0) unless these values need to be changed. The program is defaulted to select the “Ignore Adjacent Elements” and “Ignore Same Material” checkboxes.
- CWBench will automatically detect the size of the bounding box around the mesh object. To do so, press the “Load Bdy” button at bottom of the menu, and wait for the program to finish loading. It will show the (dx, dy, dz), and the average boundary patch size values for the bounding box in the respective input fields.
- Choose between either the cube or the deltahedral as the base units for building the block.
At this point it is recommended that you make registration adjustments to the geometry of the surface mesh so that it can be seen clearly in the 3D viewport when the volume mesh is loaded onto the screen. Do so by going to the Applications pull-down menu, and selecting “Registration”. The Active Matrix is automatically detected to be the boundary that was loaded.

You may use the Matrix Definition chart (under the “Matrix” property tab) to make adjustments to the boundary. Press Apply to see the changes in the 3D viewport. Be sure to move the cursor to a different input box after changing a value in the matrix so that the program will pick up the changes. You may also want to use the manual registration option (under the “Manual” property tab) to translate, rotate, and scale the boundary geometry. See Registration section of the reference manual for more details.

- Press “Next” to access the Refine menu.
- Under Refine, you may select up to 5 levels of mesh refinement operations. There are four different types of refinement:
  - AlongAllBdy – refines along the entire surface boundary of the object. The user should input the distance from the surface towards the center of the object that should be refined.
  - AlongUserBdy – refines along file (use the Browse button to from this surface boundary to the
  - WithinClosedBdy – refines all the Browse button).
  - BasedOnBdySize – refines the mesh based on the size of the surface mesh given in the boundary file. Distance towards the center of the object may be specified.
- Press “Next” to continue to the Output menu.
- Select a file for the program to write the volume mesh output to. You may create a new file by typing its name into the input box.
- Choose the format of the file(s) to be outputted:
  - Vol. Mesh Output File(s) – use the Browse button to select the location of the file. Define the distance from this surface boundary to the center of the object that should be refined.
  - Output File Type:
    - ASCII
    - Binary
  - Use default script file name:
  - Run SpMesh
  - Auto Load

Press “Next” to continue to the Ouput menu.
- WPI format – outputs one file, with extension .nml
- Thayer format (Dartmouth Thayer School of Engineering) – outputs two separate files, with extensions .nod and .elm, for the node locations and the element information, respectively.

Choose the numbering convention of the element nodes: having the normal vector pointing away (normal out) or towards (normal in) the center of the object.

Choose the output file type, either ASCII or Binary.

You may either use the mesh output filename as the name of the script file to be written by keeping the “Use default script file name” box checked, or you may browse for and type in a different name in the input box.

Before starting the program, you may choose to check the “Run SpMesh” and/or the “Auto Load” boxes:

- No boxes checked – Creates a script file that can later be used as input for the SpMesh program, run under MSDos mode.
- Run SpMesh – In addition to creating a script file, also generates a volume mesh file in the specified location.
- Auto Load – Loads the generated volume mesh file onto the CWBench 3D display view.

You may choose to output the different material surfaces, in which case you should select the “Output material surfaces” checkbox, and type in the list of materials in the input box (ex: 1, 2, 3).

Press “Apply”, a dialog box will appear to confirm your choice to generate the volume mesh. Caution: Large mesh generation processes may utilize a substantial portion of the computer’s resources, and certain tasks may cause the computer to freeze or crash. Please make sure that you have made the correct selections on the SpMesh menus before continuing.

MMC

This application is temporarily located under fMRI Module. Currently the input file type of Multiple Material Marching Cubes algorithm (M3C) is *.sdt/spr. Other input file formats are scheduled.

To run M3C, you need to select the input sdt/spr file, specify if you want the output geometry linearized or centered. If it is a threshold image, specify the low and high thresholds as well. The default x-y spacing and z spacing is ‘1’, which means the cube size is 1 in a certain slice.
and the vertical spacing is the spacing between two adjacent image slices. If z-spacing is ‘2’, it means the cubes are marching through every two slices. When the parameters are set correctly, specify the output mesh file name and hit ‘Proceed’. The file extension ‘.vtk’ is automatically appended to the filename if an extension is absent.

**fMRI Module**

**fMRI DATA PREPARATION AND ANALYSIS PRIMER**

**Introduction:**
Complete functional magnetic resonance imaging (fMRI) is a complicated and iterative analysis. This primer walks one through the steps in sequence. These steps are not convoluted. We present multiple paths to obtain the final result. An ‘Examples/fMRI-Demo/data’ folder in the CWBench main directory contains a variety of data that can be used to run this module.

**Typical Scenarios:**
- A group of N subjects is tested for responses to a given stimulus.
- The researcher wants to know several items:
  - What were the responses of each individual subject?
  - Which areas of the brain were activated?
  - Did the stimulation affect different regions of the brain at different times?
  - What is the correlation of responses for the N subjects?

These questions require that the subjects be registered (aligned) to one another and to a reference atlas. The reference atlas alignment facilitates the segmentation (color-coding) of the brain into regions and sub-regions. The brain activity can then be statistically analyzed and tabulated relative to the regions identified by the user.

The user must a) establish an fMRI project folder, perform b) registration, c) segmentation, and d) statistical (t-test) analyses in that order. Naturally, an experienced user can look at a set of slices, create a loop and run a t-test. However in that mode, they have a) registered the image by mentally picturing the area of interest, then they b) segmented the area by creating a loop around the region and finally, c) did the analysis within that loop.

We present a more formal/regimented mode which is summarized as follows:
Registration: One subject is selected as the ‘standard volume’. All other subjects are aligned to this standard subject using an automated intra-modality registration. The standard subject is then aligned to ‘the atlas’ using inter-modality registration. Finally, all N subjects are aligned to the Atlas based on the concatenated transformations that aligned each subject to a standard subject and the alignment of the standard subject to the atlas. Frequently, the automatic registration provides an approximate alignment, but not sufficient for the user. Several alternate mechanisms exist to ‘tweak’ the registration.

Segmentation: The interactive 3D brain display *Tree-Browser* is used to select the regions of interest. Based on these selections and the registration results a set of anatomy masks (segmented images) is created that classifies each pixel in the subject image space to one of the atlas regions selected via the *Tree-Browser*.

Analysis: Functional files are identified and linked to respective anatomy files. The user specifies the control and stimulation time periods. A threshold value is set to ignore all pixels with intensities below that percentage value. Positive and negative BOLD responses are tabulated. A set of images and timelines are created for each functional test. In addition a composite model is constructed that represents the average responses of all individual subjects.

There are several tabs under the fMRI module located in CWBench via “Applications → fMRI”. The first tab ‘Project’ recalls or creates a Project Folder. Within this folder the system maintains a ‘status’ file with the same name as the user specified Project Folder name with “.prj” extension. Several subfolders are created that are associated with each tab within the fMRI module. Data and results are stored within the Project Folder and sub-folders. One can press the ‘Browse’ button and select the fMRI-Demo sample folder located within the ‘Examples’ folder of CWBench. Then select ‘Recall’. Alternately, one can create a new project folder.
Preliminary Constraints:

SHORT Datatype:

CWBench has the ability to import numerous file formats. However, the statistical analysis assumes that the data files (anatomy, functional, and color-coded) are all SHORT. If the data is not in that format, we recommend using the “Tools → Conversion…” utility. This utility allows one to change data type, swap Endian status, split and/or merge files, rescale data, and convert file formats. The actions are relatively self-explanatory from the tcl gui. The Rescale option is used frequently, especially when one needs to convert a FLOAT or INTEGER to a SHORT. In order not to loose resolution the user should select ‘User Specified’ for the Input and Output choices. The code will read the input file, determine the range of data existing within the file, and use those values as default for the ‘Input File Range’. The ‘Output File Range’ will default to the range of the data type selected by the user. These default values can be changed by the user prior to pressing the ‘Rescale’ button.

Image Size Parameters:

The analyses are performed on all selected image volumes. However, it requires that each volume set has the same Row/Column/Slice count for anatomy volumes and the same Time count as well for the functional volumes. Only a singe set of controls are applied to the entire project. If the collected data vary in these parameters, we
recommend users going to the “Reslice” tab within fMRI before doing analyses. The “reslice” tool provides users the ability to specify the reference and subject data sets and get the resliced subject which is consistent in numbers of rows, columns, slices and time steps. Moreover, by “Reslice”, users can reload a resliced subject S (S=[T]R) in reference space without applying transformation matrix [T]. By default, resliced subject has the same row/column/slice/time step counts as reference. But users can specify their own image size parameters by checking the box “set new reslice parameter”.

‘Import’ the image volumes into the program.
The analysis program requires that images of interest are loaded or ‘imported’ into CWBench. To do so one can use the File → Import → Images option. Although CWBench can import a variety of image orientations, the AIR registration software is expecting “Axial from I-S” loading. Please ensure that this constraint is followed.

CCNI magnet files on the server have ‘*.sdt’ and ‘*.spr’ file extensions. One can ‘import’ these images directly from the server location, or one can copy them to the fMRI Project folder for a complete self-contained project. Bottom line: these images need to be loaded into CWBench. If one uses the fMRI-Demo example folder the anatomy files reside in the subfolder ‘data’. These images can be imported individually, or for automated loading a ‘Initial_Load.cni’ file has been saved in the fMRI-Demo directory. Use the File → Open CNI File and select the file Initial_Load.cni.

A) Registrations:
Our GUI offers several modes of registration: (4-pt inter-modality, N-pt inter-modality, Manual, linear intra-modality, and non-linear intra-modality). The recommended first step is the Intra-Modality Registration, to align all subjects to one standard subject. That is, to shift, rotate, scale each image to fit one user-selected standard image.
Intra-Modality Registration

This component of the fMRI module deals with aligning all subjects to one subject. Hopefully, it can be done automatically. The goal is to align all subjects (Subject[J]) to a standard subject. That is, Std-Subject = [T_J]*Subject[J]. In our example Subject-1 will be the Standard Subject. Select the ‘Register’ tab within the fMRI module. Press ‘Intra-R’ button (by default this button is pressed down when user first enters the ‘Register’ tab). There are two strategies for automatic intra-modality registration, 1) CCNI mutual information and 2) AIR.

1) AIR

This strategy uses the AIR registration with several of the parameter options pre-selected. The code reads the Standard Volume set and defaults the Threshold to 8% of the data range. This value can be changed. Pixels with intensities below the threshold value are not used in the alignment process. The convergence (10^{-6}) and iteration count (2500) are our recommended values.

2) CCNI Mutual Information (default strategy)

This strategy aligns the subject to the reference image by maximizing the amount of mutual information. It essentially deforms the subject image based on the transformation constraints to minimize the intensity differences of the two images. It takes longer time but provides more accurate registration results.

For both intra-modality registration strategies, select ‘Ana_One_Rat-brain’ as the ‘Standard Volume:’. All other images, (in our example, Ana_Two_Rat-brain, …, Ana_Six_Rat-brain) in CWBench’s memory are automatically loaded in the ‘Subject volume(s) to align:’ window. Any image not to be aligned
can be removed. Highlight the undesired image and select ‘Remove’. The user can select two alignment strategies: ‘Rigid-6D0F’ or ‘Affine-9D0F’. The ‘Rigid-6D0F’ alignment rotates and translates the Subject Volumes to fit the Standard volume. However, it does not scale the image set. The ‘Affine-9D0F’ alignment also allows scaling in the 3 coordinates independently. An output file is specified to store all the transformations. The file extension ‘.fmr’ is automatically appended to the filename if an extension is absent. Similarly, a second file with the extension ‘.cni’ is created. The program uses the ‘.fmr’ file information for internal use. The ‘.cni’ file allows the user to resume the process at the same state.

The ‘Align’ button performs the registration. The subject volumes are distorted to fit the Standard volume. A $[T_j]$ matrix is created for each subject. Typical alignment time ranges are (1-5) minutes per subject for AIR and (7-8) minutes for CCNI mutual information. These alignments are applied to the image volumes immediately. However, the user-specified output file will not be created until the ‘Save’ button is pressed. Prior to activating the ‘Save’ option, the user should inspect the quality of the alignments for each subject. Each subject volume ‘registration’ matrix was modified to fit the standard. The standard volume retains its ‘identity’ matrix. Under ‘Applications $\rightarrow$ Registration’ the user can select ‘Active Matrix’ and view its 4x4 values. The user can select ‘Tools $\rightarrow$ Slice Control’ and specify the background image to be the Standard volume and one of the Subject volumes as the foreground image. A variety of viewing tools exist to toggle the images, superimpose them, and alter the opacity of them. These can be used to verify the quality of the registration.

If the registration(s) are not acceptable, 3 general choices exist in order of preference: a) manually tweak the results, b) use the inter-registration alternative, or c) crop the images and do Intra-Registration again. Once the subject volumes are aligned satisfactorily to the standard volume the user specifies the output .fmr file name and selects the ‘Save’ button. This preserves the current status of the system and allows a clean restart of the project if desired, via the CNI file created.

Note: AIR and CCNI mutual information are not the only two strategies for intra-modality registration. One can also register the data sets manually by going to ‘Applications $\rightarrow$ Registration’ or by any other mode. For the fMRI module to work smoothly, one still needs to create (Save) the final aligned image volumes. In this mode the ‘Align’ button is never used. The image volumes are still loaded in the ‘Subject(s) to align’ window and a reference image is specified in the ‘Standard Volume’ tab. Any image volume not aligned yet can be aligned using tools other than the AIR option. The ‘Save’ button creates the necessary infrastructure to continue the fMRI module.

**Inter-Modality Registration**

One of the primary registrations is to align a subject to an atlas. That is to translate, rotate, and scale the subject volume such that it overlays the atlas volume set. This form of registration is inter-modality since the subject volume is intensity based (grayscale) whereas the atlas is a segmented (or color-coded) image set.

We recommend as a 1st attempt the 4-point alignment. This strategy can be incredibly fast. The down side is that it requires closely matched points and spatial separation of the points. The ideal 4 points form an equilateral tetrahedron on one subject (the Standard
subject) which will be mapped to the other volume image’s (the Atlas) equilateral tetrahedron. We demonstrate creating a triangle on one slice (the base of the tetrahedron) and a single center point on a distant slice (the tip of the tetrahedron) in the next section.

**4-Point Fiducial Registration:**

Procedure:

a) Import the images

Usually some of the volume images will already be resident in CWBench. If not, one needs to import them. File --> ‘Import’ --> ‘Image Data’ then select an image file, such as the atlas from your file folder structure. Repeat this process and import a subject data set. For this example we imported a rat atlas ‘CWBench/CWBench20bc83/bcode/Atlas/RAT_Atlas/RAT_Atlas.eci’.

‘Ana_One_Rat-brain.sdt’ was already loaded previously from the ‘fMRI-Demo/fMRI_Test/data’ folder. It is assumed that the user has a minimum of two image sets in memory. Under ‘View’ → ‘Image Data’ if one pulls down the menu ‘Active Volume’ there should be a Rat_Atlas, Ana_One_Rat-brain, perhaps other images and DefVolume for our example. Set the GUI view to be...
a 2 panel view and select one image set for each window as shown below. This setting provides ‘side-by-side’ image comparisons. One might need to adjust the orientation, such as axial view for each viewing pane. Under ‘ToolsÆSlice Control’ move the slide bar of each image set until the same distinct regions of the brain can be identified in each volume set. Preferably, select a slice towards one end of the brain. Ideally, we want to have 3 locations identified on this slice. For our example dataset we selected slice No. 154 for the Rat_Atlas and slice No. 3 for Ana_One_Rat-brain. (Slice numbers here are counted in original slice views. Another adjustment might be to decrease the increment step between slices. If the user toggles between two adjacent slices but the image seems to skip over the desired features, the slice increment can be reduced.)

Markers need to be created in both image sets. Select ‘Tools’ Æ ‘Marker’. Type in a new label for a group (ex, ‘Atlas-Markers’) and ‘Add’ this group. Select the ‘Create’ button and identify the 3 locations on the ‘Rat_Atlas’ image set. The 3 target points are M4, M5, and M6, as shown in the Figure. The user must simultaneously hold down the ‘ctrl’ key and perform a left-mouse click for each location. The ‘Markers’ do NOT show up on the 2D image (sorry). (They are 3D geometries and their locations and labels are in the 3D window only. One can select a 2x2 view and turn on the visibility of the 2D slice in the 3D window to see the location of the 3 points relative to the image.) Repeat this process for the 2nd image set, the ‘Ana_One_Rat-brain’ image set. Be sure to create a new label and ‘Add’ the group, then create the SAME 3 locations in the SAME sequence on the appropriate ‘Ana_One_Rat-brain’ image slice. (M0, M1, and M2, as shown in the Figure. If the sequence was not correct, one can move the point locations up and down in the ‘Marker’ application pallet.) Ideally, one wants the 3 points on the plane to form an equilateral
triangle that spans the 2D image slice. However, well identified and matched landmarks on the two image set slices are critical. A 4\textsuperscript{th} point NOT in the same plane needs to be identified for both image sets. The 4\textsuperscript{th} point is distant from this slice. Be sure to have the correct ‘Active Group’ identified. Since we left off with the 3 points on the ‘Ana_One_Rat-brain’ image set, we will continue and create the 4\textsuperscript{th} point. We’ve selected slice 6 of Ana_One_Rat-brain. Switching ‘Active Group’ to ‘Rat_Atlas’ we create a 4\textsuperscript{th} point on slice 104.

Two Marker sets have been created. Now to align the two image volumes based on these 4 paired points. Select ‘Inter-R’ tab within the fMRI application module. The graphics at the top of the panel indicate that the ‘Reference’ selection will be transformed to fit the ‘Subject’ space. There are three fill-in windows in the ‘Reference Information’ area. The user selects the ‘Background Image’ used and the ‘Overlaid Marker Set’ which was overlaid on this image. The third window displays the ‘Number of Points’ in the selected Marker set. A similar selection menu exists for the ‘Subject Information’ area. If more than 4 points exists in the Marker sets, the user can specify how many will be used in the transformation determination. For this example only 4 points (the minimum) exist. Select ‘Get_T_Matrix’ button to determine the transformation Sub = [T] Ref. The resultant 4x4 T matrix is displayed in the adjacent window. To verify that the transformation was sufficiently accurate, one needs to apply the matrix to the ‘Reference Image’ set. Select ‘Apply New Matrix’ and then sweep through the slices to check alignment. The effects of the transform are immediately apparent if the images are visible in the display windows. ‘Undo’ will revert to the previous matrix if selected. The marker points still exist.

If the transformation is acceptable, the user supplies a name for this T matrix and selects ‘Save’. The default name concatenates the two selected marker labels with direction in the current folder, i.e. “Reference_To_Subject” (or Atlas-Markers_To_Subject-Markers for our example).

**N Point Fiducial Registration**

If the 4-Point Inter-Registration results were less than desirable, one can perform ‘Manual’ registration to tweak the alignment. This tweak is usually performed within a few minutes. Be sure the appropriate matrix is in the ‘Active Matrix:’ window prior to adjusting any of the manual slide bars. Alternately, one can use more points in the alignment process. The ‘Inter-Registration’ module displays the number of markers in each selected data set. Adjacent to the ‘Get_T_Matrix’ is a user-selectable marker-count entry. It defaults to the lower of the two selected marker counts. The user can enter any value between 4 and the default displayed, which has a ceiling at 10 markers. Adding more fiducial points can enhance the registration. The code performs a least-squared error analysis on all the paired points. The downside is that adding more points takes more time and the sequence must be paired.

The following CNI files located in the top fMRI-demo folder can be useful for rapid reentry into this Inter-registration section. Step-2a.cni
This CNI file imports the previous images used in the Intra-Modality Registration and the Rat Atlas into memory.

**Step-2b.cni**

This CNI file has created 4 markers based on the Rat_Atlas and ‘Ana_One_Rat-brain’ images. The markers are slightly off such that manual tweaking is required after the “Get_T_Matrix” and “Apply” buttons pressed. The suggested ‘tweaks’ to the ‘Ana_One_Rat-brain’ image are (1,2,3,4,5,6,7,8,9) for the 9 manual entries in that order.

**Step-2c.cni**

This CNI file has created 4 markers that do align the two images appropriately. Further, it applied the transform on the ‘Ana_One_Rat-brain’ image such that it is aligned to the Rat_Atlas image volume. This CNI file is the start point for the next section, the Merge-Registration wherein all Subjects within the study are aligned to the atlas.
Merge-Registration
Two sets of registrations have been performed. In ‘Intra-Registration’ all Subjects (2 to N) were distorted to fit Subject-1. In ‘Inter-Registration’ Subject-1 was distorted to fit the Atlas. Merge-Registration eliminates ‘Subject-1’ as the intermediary.

\[
\{Subject - 1\} = \left[ T_{Subject(J)\rightarrow Subject(1)} \right] \{Subject - J\}
\]

\[
\{Atlas\} = \left[ T_{Subject(1)\rightarrow Atlas} \right] \{Subject - 1\}
\]

\[
\{Atlas\} = \left[ T_{Subject(1)\rightarrow Atlas} \right]
\left[ T_{Subject(J)\rightarrow Subject(1)} \right] \{Subject - J\}
\]

The user recalls the file name saved within the Inter-Registration tab for the first Browse button. The program goes directly to that location by default. Similarly, the Intra-Registration saved file is recalled for the second Browse button. A new file is created that provides alignment of all subjects (that is Subject 1 through N) to the Atlas.
B) Segmentation:

The user launches the Tree-Browser tool. Each desired region for analysis is selected. The entire shell of the rat brain is always selected. Once the desired Regions (or Volumes) Of Interest have been viewed for confirmation, the user saves the selections. These regions or volumes of interest will be identified on each subject. The user needs to close the Tree-Browser and enter or select the file just saved from the tree browser. (This is somewhat redundant, but required currently.)

The user selects the ‘*.fmr’ file recently created within the Merge-Registration tab. The ‘Run’ tab color codes each anatomy image according to the VOIs identified for a fully segmented mask of each slice. A series of color-coded (or segmented) files is created. They are stored in the same folder as the anatomy files with a ‘map’ appended to each original anatomy filename.
C) T-Test Analysis
The user selects the desired anatomy files. A good start location is the CNI file created in the Merge-Registration tab. The user must manually ‘ADD’ each functional file to the next window region. Frequently, one has multiple functional files for the same anatomy. Simply add all the functional files and duplicate the anatomy file name such that there is a one-to-one correspondence between anatomy image and functional image. If the user performed the ROI-VOI component, the segmented or masked file entries can default to those linked to the anatomy files. In that mode no selections are required. Alternately, each segmented ROI mask file is entered in correspondence to the anatomy files.

There are only 5 parameters specified by the user: the start and stop of the control period; the start and stop of the stimulation period; and the threshold value.
An output file prefix is specified by the user.
Each anatomy file in the list (some repeated for different functional tests) will have 3 graphics output files – one for positive BOLD, one for negative BOLD, and one for both. The file name will contain the ‘prefix’ (perhaps associated with the parameter settings coupled with the anatomy and functional file names and finally the P, N, or B for the BOLD settings.
A single time course file will be created for each anatomy. Two columns for each ROI will be created (positive and negative bold results).

Composite Graphics file and Time Course file?? Once we get these modules to perform as stated, the composite can be constructed with existing information.
Basic Tutorial with Examples:
The following tutorial takes you step by step through creating an *Image* file, a *Geometry* file, and a *Coupled* file that includes both Image and Geometry data. This tutorial focuses on getting the data into the CNI format. To try out the various options immediately, one can load a *.cni file within the examples folder.

**Starting Up**
Double-click on the *CWBench* desktop icon to start program. A large default window opens, displaying 5 black boxes (for 2D images), 1 green box (for 3D geometry), and a menu bar on the left hand side (for application functions). Hover the mouse arrow over most buttons or options to see a brief explanation of the function. From here you may alter the layout of the program display:

- Under the ‘View’ pull-down menu, let mouse hover over ‘Viewports’. A list of display layouts will appear to the right of the menu.
- Click on the layout that you would like to use. The program displays the chosen layout.

Next, you might choose to either open an already created *.cni* file (which may contain images, geometry, or both), or you can import specific pieces of data to create your own *.cni* file. In the following tutorial, the viewport with 4 image display windows is generally used. It is the checked viewport in the screenshot on the left. This option works within a 1024x768 window. If the 4 image display immediately below this selected one is chosen, the display is 1280x1024.

**Note:** for all pull down menus at the top of the window, there is a dashed line at the very top of the menu. You can click on that line to pull the menu out of the program onto the desktop in a small, separate window. In this mode you have access to all the options under the menu(s) without having to use the main program’s pull-down options for them. Click the ‘X’ on the upper right hand corner of the small window to close it.
1. Opening .cni files

   a. Image

Select the ‘Open CNI file…’ option from the ‘File’ pull-down menu.

![Open File dialog box]

Under the browsing window, find and click on the file to be opened (‘Examples/BrainMesh/Brain.cni). Click on ‘Open’ to load the file. (The blue bar at the bottom left of the program window indicates file opening progress.)

The opened file will be displayed on the screen. The menu bar should be automatically displaying the options of the ‘Image’ application. If not, select ‘Image Data’ from the ‘View’ pull-down menu. Under the ‘Display’ property tab are the options to manipulate the opened file.
The definition of the images can be manipulated using the drag bar next to ‘Thresholds’ or by inputting numerical values. This action sets the low and/or high end of the visibility threshold.

You can toggle the visibility of the image slices on or off by using the ‘Slice menu. Next to the slice name whose color code the ‘V’ to turn the visibility of the slice on. Press many slices as you would like to become in the 3D box to give you a good idea of where in the actual human head.

<table>
<thead>
<tr>
<th>Thresholds</th>
<th>Auto Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low: 0.0</td>
<td></td>
</tr>
<tr>
<td>High: 355.0</td>
<td></td>
</tr>
</tbody>
</table>
The image slices may be registered (translation and/or dilation) to fit a certain model by using the ‘Registration’ application. The drag bars on the Registration menus are available to manually alter the images. Numerical values may be input as well for more accurate results.
b. Geometry

Select the ‘Open CNI file…’ option from the ‘File’ pull-down menu.

Under the browsing window, find and click on the file to be opened (‘Examples/BrainMesh/BrainMesh.cni’). Click on ‘Open’ to load the file. (The blue bar at the bottom left of the program window indicates file-opening progress.)

The opened file will be displayed on the screen. When working solely with a file containing geometry, you have the option of changing the viewport to one single 3D window for better viewing. In this viewport, you may manually change the size of the program window by clicking and dragging a corner of the window.

The menu bar should be automatically displaying the options of the ‘Image’ application. If you would like to work in the Geometry application, select ‘Geometry’ from the ‘View’ pull-down menu.

Use the ‘Display’ property tab to manipulate the geometry and toggle the different features on or off. Change the opacity of the desired feature by clicking and dragging the bar next to the word or by inputting a numerical value from 0 to 1 (0 being
transparent and 1 being opaque). Toggle the feature’s visibility on or off by depressing the button with its name on it. Right clicking on the names of the geometry features (eg. Skin, vessels, ventricles) offers more options to you, such as altering the color of the feature.

You may choose to display the figure either rendered using mesh (wireframe) or smooth surface.

A mesh rendering of the same geometry shown above looks like this:

Under the “Utilities” tab, you may select a type of movement for the 3D figure in the green box. (Rotate, Spin, or Pan). Then press the arrow in the direction that you would like the movement to occur. The figure in the 3D window will move as desired.
c. **Coupled (Both Image & Geometry)**

Select the ‘Open CNI file…’ option from the ‘File’ pull-down menu.

Under the browsing window, find and click on the file to be opened (Brain_Regis.cni). Click on ‘Open’ to load the file. (The blue bar at the bottom left of the program window indicates file opening progress.)

You may use both the features under the ‘Image’ and ‘Geometry’ applications for this file.

By toggling both image slices and geometry features on, the model gives you a guideline as to where the slices are located in terms of the facial features of a human. In order to see what is under the skin of the model, it is often best to decrease the opacity to a comfortable degree so that the slices within can be easily seen and still compared to the skin. The same applies to any opaque ventricles or vessels.

In Geometry, under the “Clip” property tab, you have the option of using the slice planes to act as clipping planes to view inside the model. Turn the slice planes on or off and select to clip the portion of the model lying on its positive or its negative side. You may change the effect of clipping with multiple planes.

To clip a particular model, you must turn on the clipping attribute for that model by right clicking the model name under the ‘Display’ tab and selecting ‘clipping’ or by doing it under the ‘Import’ tab’s Advanced section.
Importing images to create a CNI file

After opening CWBench, you may import either image data or geometry data:

**Image Data:**

Under ‘File’, hover cursor over ‘Import>’, and press ‘Image Data’ on the menu appearing adjacent to File menu. This action will open up the ‘Import’ tab under the Image application. You may choose to open up to this tab manually, by first choosing ‘Image Data’ from the ‘View’ menu if it is not already there, and then clicking on the ‘Import’ tab.

Next to “First Image File:”, click the ‘Browse…’ button. This will bring up a menu where you may select the file from your computer, which will be the first image you would like to import (example: Examples\BrainMesh\Images\BrainSag.001). When you press ‘Open’, the program will automatically detect the remaining image data files in the current folder, and put the number of the last image in the box labeled as such.

The next few input boxes are automatically set for you as well. You may change any information in the input boxes to your discretion.

Make the required selections for Image Headers (automatically if available, or manually) and type of Image Data (either as grayscale for label map).

You may give the files a name and/or a description

Press Apply to import the files, cancel to abort.
If you chose to enter the Image headers manually, a menu will open to ask you for specifics. Enter the header information as desired, and press Apply to import the images. The blue bar at the bottom shows import progress.

After any desired manipulations have been made to the images, select ‘Save CNI as’ from the File menu. Enter a name for the .cni file, the file type should automatically be chosen as a .cni file. Press Save to complete the file save. Now you have a complete .cni file made from imported image data. You may open it from now on using the ‘Open CNI file’ option.

Geometry Data:

Under ‘File’, hover cursor over ‘Import>’, and press ‘Geometries’ on the menu appearing adjacent to File menu. This action will open up the ‘Import’ tab under the Geometry application. You may choose to open up to this tab manually, by first choosing ‘Geometries’ from the ‘View’ menu if it is not already there, and then clicking on the ‘Import’ tab.

Press the ‘Browse…’ button to open find the .vtk file which contains the geometry data you would like to open (example: Examples\BrainMesh\Images \Miga-composite_v1.vtk). Press open.

The program automatically detects the name and color of the file, although you may opt to change them if you wish. (There appears to be a bug here, where the default color before pressing ‘apply’ is different from the resulting color. You may go back to the import tab and select the correct color, then press apply again.)
To reassign a color, press the ‘Color’ button to find the desired color. You may enter RBG codes, select from some predefined colors, or pick a color from the spectrum at the lower right. To define a custom color for the predefined color chart, give the selected color a label name.

Check or uncheck the visibility box to define if the geometry being imported will be visible. Manipulate the opacity of the geometry being imported, by dragging the pull bar. Opacity is given on a scale of 0–1, 0 being transparent and 1 being opaque. You may input a numerical value on this scale if you wish to have a certain opacity.

After making the necessary manipulations to the geometries, you may save the data as a .cni file. Press ‘Save CNI as’ under the file menu, and give the file the desired name. It will save as a .cni file, which you may open up from now on using the ‘Open CNI file’ option.
Troubleshooting:

Problem: *The CWBench does not fully open up when I try to open it, and the program stops responding after a few moments.*

Solution: Your hardware acceleration may be on a setting that is too high to run CWBench. First close the CWBench (you may need to use the task manager to end the task if the program is not responding). Go to My Computer, then Control Panel, and Display. Under the Settings tab, go into the Advanced options. Then open the Troubleshooting tab, and decrease the Hardware Acceleration down to about 2 notches or less. Now apply the changes, and open CWBench again. You may need to restart the computer if CWBench’s initial freeze caused other vital system programs to malfunction.

Problem: *When I try to toggle the visibility of image slices on or off so that I can see them displayed inside the geometry model, I do not see these slices being displayed.*

Solution: First try decreasing the opacity of the geometry model. When the model is entirely opaque you cannot see anything inside of it. Otherwise, ‘Backface Culling’ may be ON for that particular model. Turn it off by right clicking on the model’s name under Geometry’s display tab. If you still do not see slices being displayed, you should exit CWBench from the File Menu and restart the program. Save any work that is important before exiting.

Problem: *When I am importing a geometry, the detected color of the model on the import menu is not the same as the resulting color of the model after being imported.*

Solution: This may be a bug in the software. You may go back to the import tab and select the correct color, and then press apply again.
Application Function Tree:

IMAGES
‘Display’ property tab:
- Active volume selection: (for image parameter modifications)
- Width/Level : automatic or manual
- Width : Drag bar (width of the contrast levels within the data)
- Level : Drag bar (mid location of the grayscale intensity value)
- Threshold: automatic, manual, or apply
- Lo : Drag bar to determine lower end threshold of image definition
- Hi : Drag bar to determine higher end threshold of image definition
- Palette (color scheme of slices): gray, iron, rainbow, natural, or label
- Interpolation: On or Off
- Intensity spectrum distribution of image set

‘Import’ property tab:
- Properties : Basic, Header, or DICOM
- First image file: press browse to select file from computer
- Number of last image
- Slice Range From: (input slice value) to (input slice value)
- Time steps from: (input time value) to (input time value)
- Image headers: automatic or manual
- Image Data : grayscale or label map
- Name: (enter name for slice)
- Optional Description: (input a description of the slice)
- Apply or Cancel modifications

‘Export’ property tab:
- Select Volume: which volume to export
- Orientation: which orientation as primary output
- Properties :
  - Export
    - Browse button to specify output file name and pathway.
    - File Pattern: 1 file (all images stored in one file); Set x.00i (each image numbered sequentially with range of 000-999 available); Set x.i (each image numbered sequentially without any leading zeros in the file name structure)
- Number of Slices
- File Format Type
- Scalar Type
- Endian Type

or

- OriHead (subwindow to display orientation and header information prior to export.
  - File Pattern: 1 file (all images stored in one file); Set x.00i (each image numbered sequentially with range of 000-999 available); Set x.i (each image numbered sequentially without any leading zeros in the file name structure)
  - File Type:
  - Image Width: and Height:
  - Pixel Width: and Height:
  - Slice Thickness and Spacing
  - Time Start and Interval
  - Origin X, Y, and Z location
  - Scalar Type
  - Scan Order (Sagittal: Left to Right; Coronal: A → P; etc.)
  - Headers Size
  - Endian Type

- First image file: press browse to select file from computer
- Number of last image
- Slice Range From: (input slice value) to (input slice value)
- Time steps from: (input time value) to (input time value)
- Image headers: automatic or manual
- Image Data: grayscale or label map
- Name: (enter name for slice)
- Optional Description: (input a description of the slice)
- Apply or Cancel modifications

‘Other’ property tab:
- Slider range: automatic or manual
- Low
- High

Help tab:
- Help information specific to ‘Images’ Application

GEOMETRY
‘Display’ property tab:
- Rendering screen selection: viewRen, default
- Render types: wireframe (mesh) or surface (3D), default
- Visibility/Opacity of :
  Any/All Geometry Models loaded :
    Drag bar to manipulate opacity of object
    Select button to toggle visibility of object on or off
    Right-click for additional visibility settings
- Show all or show none

‘Import’ property tab:
- Active model selection: select any geometry model already loaded
- Properties: basic or advanced mode
- Basic mode:
  New model file (.vtk): Browse to select file from computer
  Name:
  Color:
  Visible: check box, yes or no
  Opacity, for a default setting
  Apply or Cancel modifications
- Advanced mode:
  Clipping: check box, yes or no. Each geometry model has the option of being subject to the clip settings for 3D viewing
  Backface culling: yes or no
  Scalars visible: yes or no (Labeled relative to a color spectrum)
  Scalar range: input low value (0), input high value (100)
  Optional description: enter a description of the imported object

‘Clip’ property tab:
- (color coded) slice: off, +, - (+ clips the positive side of geometry)
- Clipping type: union or intersection
- Apply modifications

‘Utilities’ property tab:
- Moving type: press the directional arrows to move the object in that direction
- Rotate, Spin, or Pan: select what type of movement the arrows will make
- Measure Performance (inactive)

Help tab:
- Help information specific to ‘Geometry’ Application

SLICE CONTROL
‘Controls’ property tab:
- Foreground slice opacity: drag bar to manipulate opacity. Press button to toggle option on or off. Requires an image set in both the foreground and background
- Slice range: automatic or manual
- From (input beginning value) to (input end value)
- Color coded sections for slices:
- Slide bar indexes through the available slices
- Adjacent box is an explicit slice number
- ‘V’ if activated makes the image visible in the 3D window
- ‘R’ reformats the slice
- ‘Or:’ Orientation
  - left box applies to entire image set
  - right box applies to specific color-coded window
- ‘Bg:’ Background
  - left box applies to entire window set
  - right box applies to specific color-coded window
- ‘Lb:’ Label Layer identification
  - left box applies to entire image set
  - right rectangle applies to specific color-coded window
- ‘Fg:’ Foreground
  - left box applies to entire window set
  - right box applies to specific color-coded window
- Active slice color: red, yellow or green
- Save active: (slice)
- Show advanced slice controls:
  Zoom: input value (1.0)
Slice increment: input value (1)
Close advanced view

Help tab:
- Help information specific to ‘Slice Control’ Application

REGISTRATION
‘Matrix’ property tab:
- Active matrix: specifies which dataset is being modified by registration
- Properties: basic or advanced
- Basic mode:
  Name: of the active matrix
  Matrix: the 4x4 matrix in a single string
  Matrix Definition: the 4x4 individual transformation values
  Apply or Cancel modifications
  Matrix operation: identity or invert
- Advanced mode:
  Optional description: enter a description
  Get matrix from Volume: can recall a different volume set’s matrix as initial settings for the current active volume set
  Type of matrix: none, RAS -> VTK, scaled IJK-RAS, or RAS -> IJK (various right hand rule, left hand rule, vtk coordinate protocols)
  Apply or Cancel modifications

‘Manual’ property tab:
- Active matrix: specify which matrix will be modified by subsequent changes
- Render: 1 slice, All Slices, or 3D. Generally want transforms to apply to all
- Translation (mm): modifies image position
  LR – left/right axis
  PA – Posterior/anterior axis
  IS – inferior/superior axis
- Rotation (deg): rotates image on LR, PA, or IS axis
- Scale factor (0-3): dilates image on LR, PA, or IS axis
- Mouse action: translate or rotate

‘Auto-AIR’ property tab:
- not operational yet.
Help tab:
- Help information specific to ‘Registration’ Application

**MESH GENERATION**

‘SpMesh’ property tab:
Generate tetrahedral mesh on cube or deltahedral building blocks.

**(Input)**
- Boundary Input File: Browse for filename
- Internal Normalization Factor: default at 1.0
- Maximum Auto-refinement Limit: default at 0
- Checkboxes: Ignore adjacent element, Ignore same materials
- Bounding Box Size (dx, dy, dz) & Average Boundary Size: may be manually input, or automatically determined by pressing “Load Bdy”
- Build Block: Cube or Deltahedral
- Initial Build Block Ratio/Size: default at 1.0
- Radio buttons: Ratio to Average, or Absolute Size

**(Refine)**
- Choose type of refinement for up to 5 levels
- Input the distance of refinement from the specified surface towards the center (if necessary)
- Select the boundary filename if necessary

**(Output)**
- Volume Mesh Output File(s): Browse for or create new filename
- Output Format: WPI (.nml) or Thayer (.nod & .elm)
- Element nodal numbering convention: Normal towards center (normal in) or away from the center (normal out)
- Output file type: ASCII or Binary
- Check checkbox to use default script file name (same name as vol mesh output file, with different extension). If box is unchecked, then browse or input a filename.
- Select RunSpMesh to create a volume mesh file in addition to the Script file.
- Select Auto Load to display the volume mesh that was created (displays in 3D viewport).
- Check Output material surfaces, and input the list of materials to output, separated by commas.
- Press Apply to begin mesh generation.

‘OffSet’ property tab:
  Offsetting Mesh Generation.
‘MMC’ property tab:
  Multi-material Marching Cube.
‘Help’ property tab:
  Find appropriate help documentation about Mesh Generation menus and functions.